
EG1003: Help’s and How To’s: Revit Tutorial 

Helpful Mouse Tips: 

To zoom in and out, scroll with your mouse.  

To highlight something, click and drag over the object. To highlight multiple objects, click on 

one, hold “ctrl”, then click the rest you would like to highlight.  

To pan around your view, click/hold your mouse’s scroller and move your mouse.  

In your 3D view, to pan and rotate at the same time, hold “Shift”, and click/hold your mouse’s 

scroller, then move your mouse. 

  



1. Introduction 

Open Revit. Under the home page, there is a column labeled “Projects”. Select “Architectural 

Template”. Each template is for a different type of design. For example, if you want to design 

HVAC (Heating, Ventilation, Air Conditioning) systems, you would open up a Mechanical 

Template. We will be working in the Architectural Template for most of the project. 

 

This is your home screen for a project. On the left, there is a column called “properties”, and 

below it is a column called “project browser”. At the top of this window is the tool bar.  

  



2. Setting Levels/Getting Started 

The most important part of getting started is defining the levels of your project (the story heights 

for the building). 

Go to the Project Browser column on the left, and double click on the East Elevation. This will 

open up a window that shows the view of the East elevation of your project. You can switch 

between any view by double clicking on the level or elevation name. A new window of that 

view will open (don’t worry—your first window isn’t gone, it’s just behind your new view!).  

 

  



When your window opens, double click on the current height and name of the existing levels to 

change them. Remember to check your units when you are typing in numbers! To add a new 

level, click the black and white circle icon in the toolbar under “datum”. For a shortcut, you can 

also type “LL” and your cursor will automatically be ready to draw a new level. To delete a 

level, just click on it and press “delete”. Once you have set your levels, you can start building! 

 

  

Add a new level 

Adjust current level 



3. Views  

If you would like to view all of your views at once, you can go to the “View” tab in the toolbar, 

go to the “Windows” subtab, and click the icon with one rectangle on top of the other. This is the 

“Tile Windows” option. You can also just type “WT” on your keyboard as a shortcut. 

To view your 3D model, go to the “View” tab in the toolbar, under the “Create” subtab, click 

“3D View”.   

When you highlight/select one object in your project, it is selected in ALL windows. If you have 

all windows open at once and select an object, it will be highlighted in each window. This is 

helpful in locating or viewing certain objects’ placement. 

Along the bottom of your window is a toolbar with various symbols. Hover over each symbol to 

figure out what each one does. The most important functions in this toolbar are the two symbols 

highlighted below.  

 

The first highlighted symbol is the visual style of your drawing. Wireframe is the most useful 

style to build in because you can see through all of your objects. 

The second 2 highlighted symbols work hand in hand. If you would like to hide certain objects 

while you are drawing, right click on it and click “hide in view”. You can also select objects and 

then click the glasses symbol to hide an object. Hiding an element means only hiding the 

object(s) you selected. Hiding a category means hiding every object that is the same as the object 

you selected.  

The lightbulb symbol, when clicked, shows everything that you have hidden in pink, along with 

your existing structure (like the upside down in Stranger Things!). These two functions are 

helpful when you want to build on the interior of your structure, but your walls are blocking your 

vantage point. 

 

  



4. Building 

In the Project Browser column, go back to your 1st level under “Floor Plans”. You should always 

be building from the ground up, so start at Level 1.  

To start, build your walls under the “Wall” function in the “Architecture” tab of the toolbar. 

Build an Architectural Wall. When you click on the function, a new tab called “Modify” should 

appear on the far right of the toolbar. This happens for any new structure you are building. Click 

what type of line or shape you would like to draw, and draw it on your view. 

 

If you made a mistake in your initial drawing, you can always double click on the dimension in 

blue, and change it manually by typing in the correct value. Once you are done modifying the 

wall, click the “esc” button.  



After you have created walls for your structure (just level 1), you can add floors, ceilings, doors, 

and windows. Just click on the structure you would like to add, and place it on your structure. 

For floors and ceilings, you will need to provide a “boundary” that your floor or ceiling will 

follow. This boundary is the perimeter of your building that you created when you build your 

walls.  

Click “Floor”, and under the modify tab, it will prompt you to pick a line type to draw your 

boundary. Simply click on your walls that you created, then click the green check mark.  

 

The procedure for ceilings is almost the exact same. After clicking “ceiling” under the 

“architecture” tab, it will prompt you to create an automatic ceiling or if you want to sketch the 

ceiling manually. If you have a simple wall design (such as a single rectangle), you can use an 

automatic ceiling. If you have a more complex wall design shape, click sketch ceiling. The 

procedure to sketch your ceiling boundary is the same as the floor boundary. 



To insert a roof onto your building, click “roof” in the architectural tab and draw its footprint 

(same as a boundary). Revit will ask if you would like to move the roof you are about to create to 

the next level (Level 2), click yes. After drawing your roof footprint and clicking the green check 

mark, Revit will ask you if you would like to attach the highlighted walls to the roof. Click yes. 

NOTE: you MUST do ceilings and floors BEFORE you build your roof. 

 



Once you click the green check mark, your roof will be created. It should look similar to this: 

 

If you would like to change the height of the roof, click and drag the arrows at the peak of the 

roof.  

To install stairs, go to the level that you would like your stairs to start on. For this example, we 

will be starting on level 1, building stairs up to level 2. Double click on “Level 1” under “Floor 

Plans” in the Project browser column. Select the Stair command in the Architectural tab of the 

toolbar. Once you’ve placed your stairs on level one, click the green check mark and navigate to 

your 3D view. Your stairs are visible but are coming right out of your floor on the second level.  

NOTE: to do this next step, you must build a floor on your second level. 

Double click on the ceiling you created on your first floor (this can be easily done in the 3D 

view, but may be hard to locate in your level 1 plan view). You should now be in the modify 

mode for your ceiling. 



 

Using the compass in the top right of your screen, click on “TOP” to get a overhead view of your 

stairs. In the “Modify | Edit Boundary” tab of the toolbar, click the rectangle icon and draw a 

rectangle around your stairs, so that you make a “cut” or “gap” in your floor. 

 

Click the green check, and do the same procedure for the ceiling. When you’ve finished, your 

stairs should look like this.  



 

NOTE: This is a 3D view, with one wall temporarily hidden so that you can see inside the 

building. 

You can modify your stairs’ length, height, and other dimensions by double clicking them.  



5. Modifying Objects & Changing Properties 

When you select an object, its specific properties show up in the properties column on the left. 

For example, if you click on a door that is in your structure, the properties toolbar will show its 

type along with other details. If you would like to change something about the door you are 

using, click “Edit Type”. Here you can change dimensions, color, material, etc.  

 

If you would like a completely different door (this procedure also applies to windows, walls, 

columns, etc.), click “door” under the architecture tab as if you were going to add a new door to 

the project. Under the “Modify” tab on the toolbar is a command called “Load Family”. Click it, 

and this window should appear: 



 

Navigate through the folders to find which object you would like to load into your project. Once 

you have clicked it and approved, click “Open”. Revit will ask you which type/dimensions you 

want. Select the one you want and click “Ok”. Now when you click the “door” command, you 

will have multiple doors to choose from. 

 

  



6. HVAC Building (Still in Progress: issue w Ducts I haven’t been able to figure out) 

For the most part, this tutorial covers building within the Architecture tab. To build 

HVAC systems, navigate to the “Systems” tab in the toolbar. A new set of commands such as 

“duct”, “pipe”, etc. are available. To do ductwork for a level, it is best to do it in the 3D view, 

because it will not be visible in your Level 1 or Level 2 floor plan or ceiling views.  

NOTE: Alternatively you can change the parameters of your view in the properties column 

when nothing is selected. Go to Extents View Range Edit and you can change the range of 

view for a certain plan. 

To draw ducts, select the “Duct” command and begin drawing.  

  



7. Annotating 

 To assign dimensions to your structure, go to the “Annotate” tab in your toolbar. Click 

“Aligned” to assign dimensions that are parallel or along the same line. Use the “Linear” 

command to annotate a single object at a time. These commands work for objects such as doors, 

windows, walls, and heights. If you would like all of your windows or doors in a segment to be 

equidistant, click the “EQ” symbol above your new annotations. 

 To assign elevations, use the “Spot Elevation” tool in the annotate tab.  

  



8. Schedules 

 To create a schedule (a list of objects in your design) for your structure, go to the “View” 

tab in the toolbar, and click on the following symbol: 

 

Click “Schedule/Quantities”. A window should pop up where you can type in the name of your 

schedule such as “Doors” or “Windows”. Click the category you would like your schedule to be 

about. Keep the phase on “New Construction”. Add whatever properties you would like to 

include the schedule. Helpful ones are shown below. 

 

 



Use the green and red arrows to add and remove items from your schedule. Click ok and your 

new schedule will be created. To view all of your schedules, go to the “Schedules/Quantities” tab 

in the Project Browser Column.  

  



7. Drawings/Sheets 

 Presenting your structure and design is one of the most important parts of a project. To 

create drawings with all of your views, plans, schedules, right click on “Sheets” in the project 

browser column. Click “New Sheet”. Click Ok. A blank sheet will open. 

NOTE: To modify certain aspects of the sheet such as the Autodesk logo (should be changed to 

your company’s logo), double click on it and it will open the sheet in a new window, but so that 

you are modifying it. You can also change the project name, owner, and number of the sheet. 

To add a view to your sheet, simply click and drag it from the project browser column.  

 

To change the size of the plan on your sheet, go to the plan you are trying to put on your sheet, 

and change the size ratio of the drawing. You can do this by going to the bottom toolbar (see part 

3: Views of this tutorial for help) and clicking the ratio. The default is set to 1/8” = 1’-0”. To 

make the view smaller on your drawing, make your ratio smaller (i.e. 1/6” = 1’-0”). The size will 

decrease significantly.  



 

 

 

 


